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Introduction

Site Book is used for configuring communications options for
N30 Supervisory Controllers, M-Tool, and M-Series Workstations.

This document describes how to:

check the Ethernet related addresses of a Personal Computer (PC)
running Windows® 98 software

check the Ethernet related addresses of a PC running
Windows NT® software

check the Ethernet related addresses of a PC running
Windows 2000 software

set the Ethernet related addresses on a PC running Windows 98
software

set the Ethernet related addresses on a PC running Windows NT
software

set the Ethernet related addresses on a PC running Windows 2000
software

add an Ethernet Local Area Network (LAN) site to Site Book
add device addresses in Segment Hop (SHOP)

add device host names in SHOP

delete device addresses or host names from SHOP

add a direct serial or dial-up (modem) connection site

use Browse Site Database

add a device

find devices

edit a device host name

3
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e delete a site from Site Book

e connect to an N30 site from Project Builder via a direct serial
connection

e change the Point-to-Point Protocol (PPP) password
e change the BACnet® IP Port

Note:

Unless otherwise indicated, the information in this document
applies to all N30 and N31 Supervisory Controllers.
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Key Concepts

Related Documentation

See the documents in Table 1 for more information.

Table 1: Related Documents

Topic Document
Overview of N30 Networks, N30 Supervisory Controller Quick Start
Including Flowcharts and Technical Bulletin (LIT-6891200)

Checklists of Tasks

Setting Up an N30 Network N30 Supervisory Controller Networking
Technical Bulletin (LIT-6891300)

Setting Up Direct Serial and Direct Connect and Dial-up on Windows NT
Dial-up (Modem) Connections Application Note (LIT-6893400)

Direct Connect and Dial-up on Windows 98
Application Note (LIT-6893350)

Direct Connect and Dial-up on Windows 2000
Application Note (LIT-6893450)

Using Project Builder Project Builder User’s Guide (LIT-693200)

Using M-Series Workstations = M-Series Workstation Manual

Communications Options

When communicating with an N30 Supervisory Controller from
M-Tool or an M-Series Workstation, connect using one of

three methods: direct serial connection via serial cable between your
PC and the N30, dial-up connection via telephone lines using modems,
or network connection via Ethernet.

N30 Supervisory Controller

The N30 Supervisory Controller monitors and controls the Heating,
Ventilating, and Air Conditioning (HVAC) related equipment in a
facility. It uses powerful data gathering and energy management tools
to help make a facility economical and cost effective. Facility
personnel review the system status and modify control parameters for
the N30 and its associated Application Specific Controllers (ASCs)
using the Local Display Terminal (LDT) installed in certain models, a
VT100 Terminal, or an M-Workstation.
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Project Builder

Part of the System Tools in M-Tool, Project Builder is a software tool
used to create and edit building engineering projects offline. These
projects may be uploaded from and downloaded to the devices used in
the building. It allows you to import configuration files from other
Johnson Controls tools such as HVAC PRO™ software and GX-9100
Graphic Configuration software.

N30 Upgrade Utility

The N30 Upgrade utility upgrades N30s from firmware

Revision Level 1.x to Revision Level 2.x. It is used when a Project
Builder database for the N30 is not available or the available
Revision Level 1.x database is not current.

M3 Workstation

The M3 Workstation software application suite includes monitoring,
commissioning, and analysis features. It works in combination with
Companion™/Facilitator™ Systems and N30 Series Supervisory
Controllers to provide a complete facility management solution.

M5 Workstation

The M5 Workstation provides extensions and enhancements to the
Metasys® Operator Workstation (OWS) and works in combination
with Network Control Modules (NCMs) and N30 Supervisory
Controllers to provide a complete facility management solution.

Site

A site is a logical grouping of multiple N30 or N31 Supervisory
Controllers interconnected on an Internet Protocol (IP) network for the
purpose of communication with each other. We recommend defining
no more than 50 sites in the Site Book.
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Direct Serial or Dial-up (Modem) Connection

Dial-In

Specific operating systems have different steps to set up the initial
direct connection. Where this document talks about setting up direct
connect in Site Book, we assume you have done the initial setup on a
PC running Windows 98, Windows NT, or Windows 2000 software.

For more information on setting up direct connect for a specific
operating system, see the appropriate document from the list below:

e Direct Connect and Dial-up on Windows 98 Application Note
(LIT-6893350)

e Direct Connect and Dial-up on Windows NT Application Note
(LIT-6893400)

e Direct Connect and Dial-up on Windows 2000 Application Note
(LIT-6893450)

Alarms from N30 systems can dial in automatically to an M-Series
Workstation on a PC running Windows NT software. If you are using
a Windows NT Workstation or a workstation with Windows 2000
Professional, alarms can dial in from one site at a time. If you are
using a Windows NT Server, multiple sites can dial in at the same time
with alarm messages.

Transmission Control Protocol/Internet Protocol (TCP/IP)

The suite of communications protocols used to connect hosts on the
Internet. TCP/IP uses several protocols, the two main ones being TCP
and IP. TCP/IP is used by the Internet, making it the defacto standard
for transmitting data over networks.

Point-to-Point Protocol (PPP)

A protocol for communication between computers using TCP/IP, over
standard telephone lines, Integrated Services Digital Network (ISDN)
lines, and other high-speed connections. PPP can connect a computer
to the Internet. PPP can be used with both synchronous and
asynchronous transmission.

Ethernet Connection

Connection made over an Ethernet network. Ethernet is a popular
network topology. The Johnson Controls N30 Series Supervisory
Controllers support Ethernet at 10 Megabits per second (Mbps). The
network hardware of PCs may have Ethernet support built on to the
motherboard and generally have 100/10 Mbps Ethernet interfaces.
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Building Automation Control Network (BACnet)

The BACnet standard is a protocol developed by the American Society
of Heating, Refrigerating, and Air Conditioning Engineers (ASHRAE)
for intervendor communication.

IP Address

Internet Protocol (IP) is the family of protocols to which the TCP/IP
network-level protocol belongs. The IP address clearly identifies a
node on the network and assists in the routing of messages on the
BACnet network. Each network node must have a unique IP address.
The factory default range for unique IP addresses assigned to N30s is
172.16.(64 to 127).(0 to 255). An example of an I[P address is
172.16.68.243.

IP Mask (or IP Address Mask)

Subnet addressing uses the IP mask supplied by the system
administrator. It specifies which bits of the IP address correspond to
the network address and which bits of the IP address correspond to the
device address. This is different from the IP broadcast distribution
mask, which is data required for BACnet compliance and used when
adding a Broadcast Management object. Do not change the default

IP broadcast distribution mask. The Broadcast Management object is
discussed later in this document.

IP Router Address

This IP address identifies a router device on the local Ethernet
segment. The Local Area Network (LAN) administrator can supply
this information.

BACnet IP Port

The BACnet IP Port isolates a set of N30s on a single Ethernet
segment to a separate site. For example, if an N30 system requires
more than fifty N30s or requires isolation from other N30s, use
separate BACnet IP Port numbers. N30s must have the same BACnet
IP Port number to communicate with each other. The default value is
47808, which is BACO in hexadecimal.

Setting the BACnet IP Port value takes place in the Site Book when
the site is configured. If the connection information is defined as
Ethernet, the BACnet IP Port must be defined.

Note: ~ The BACnet IP Port can be modified only in the
N30 Supervisory Controller. N31 Supervisory Controllers
are preset to BACO at the factory and are not editable.
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Network Address

The network address identifies the network. The network address is
used for message routing at the BACnet network layer. It must be
unique for each BACnet network segment.

All nodes on all Ethernet segments must specify the same network
address because they are considered one BACnet network segment.
Since an N30 can support both direct serial connections/dial-up
(modem) connections and Ethernet simultaneously, the serial ports and
Ethernet port must have different network addresses.

The default value for Ethernet is 1001. The default for direct
serial and dial-up (modem) connections is 100. For N30
networking purposes, do not change the default.
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IP Protocols

The N30 supports several IP protocols including Bootstrap Protocol
(BOOTP), Domain Name System (DNS), and Simple Mail Transfer
Protocol (SMTP). These protocols can be used independently of one
another. For example, a site may include a BOOTP server but not a

DNS server.

BOOTP

BOOQOTP allows a device (such as an N30) to obtain and configure its
own IP information. The device sends a request to the BOOTP server
and the BOOTP server responds by providing the device its

IP information, such as its IP address and, if a DNS server is also used,
its host name. For N30 networking, configure the BOOTP server to
assign static IP addresses to devices.

A BOQTP server is not required in order to provide BOOTP protocol,
however. Most Dynamic Host Configuration Protocol (DHCP) servers
can be configured to accept and respond to BOOTP requests. To
assign IP addresses using BOOTP protocol, configure the DHCP
server to accept BOOTP requests. This allows a DHCP server to
dynamically assign a specific IP address to a device based on its Media
Access Control (MAC) address.

Note: In this document, the term “BOOTP server” refers both to
BOOQOTP servers and to DHCP servers configured to accept
BOOTP requests.

By setting the BOOTP Enabled attribute of an N30 to True, you allow
the N30 to obtain and configure its IP address, IP mask, IP router
address, host name, domain name, and DNS server IP address. See the
N30 Supervisory Controller Networking Technical Bulletin
(LIT-6891300). Also see the N30 Device chapter in the Object
Dictionary.
Note: When a network includes both BOOTP and DNS servers,
make certain that host names and IP addresses provided by

the BOOTP server are consistent with those configured in
the DNS server.
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DNS

DNS allows the conversion of text-based names (such as a Web site
address) into numeric IP addresses. With a DNS server, you can assign
a host name (such as N30-Floor3) to an IP address (such as
172.16.68.243). An N30 uses the Object Name of the device object as
its host name. A host name can be reassigned to different IP addresses
as needed.

Note: When a network includes both BOOTP and DNS servers,
make certain that host names and IP addresses provided by

the BOOTP server are consistent with those configured in
the DNS server.

A DNS server simplifies the work of identifying individual devices on
a network. For example, when setting up Broadcast Management
objects, you can elect to identify an object by its host name rather than
entering its [P address. See the N30 Supervisory Controller
Networking Technical Bulletin (LIT-6891300).

Broadcast Management Object

A Broadcast Management (called BACnet Broadcast Management
Device [BBMD)] object at Release 1.0) object is added to N30s on
different network segments to allow communication between segments
in a situation where broadcasts cannot be sent (for example, when
using an IP router). A Broadcast Management object contains a list of
all the IP addresses and IP broadcast distribution masks for all the
N30s with Broadcast Management objects. We recommend N30
Broadcast Management objects also include the IP addresses of
workstations that are permanently connected to the network.

When establishing a dial-up connection with an N30 network
containing Broadcast Management objects, do not download through
the N30 that has the Broadcast Management object. Since the N30
with the Broadcast Management object has additional traffic on it due
to the Broadcast Management object, using this N30 to download
through a dial-up connection can be slow.

IMPORTANT: Do not use Broadcast Management objects with N30s
that do not need to communicate across network
segments. Do not use Broadcast Management objects
on more than one N30 on a network segment for a
standard configuration. Either of these situations can
cause communication problems. See the N30
Supervisory Controller Networking Technical
Bulletin (LIT-6891300) for information on using
Broadcast Management objects.
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Segment Hop (SHOP)

SHOP provides a communication link between N30s and/or M-Series
Workstations that exist on different physical Ethernet segments within
a single site. SHOP is similar in function to Broadcast Management
objects but is used in M-Series Workstations and Project Builder.

SHOP contains a list of all IP addresses for all the N30s with
Broadcast Management objects. The user can add, delete, and save the
IP addresses by clicking the SHOP button in the advanced
configuration mode. The user can enable or disable broadcast

messages between the Ethernet segments. Broadcast messages are
enabled by default.

The addresses of the devices that have Broadcast Management objects
on your network segments are entered on this screen to allow
communications between separate BACnet nodes.

Network Connection Icon

A network connection icon is a representation of a dial-up connection
profile in the Microsoft® Windows 98 operating system. Connection
profiles allow a user to have the computer dial out to a number of
different Internet connection points. The network connection icon is
the Windows system element that contains the information necessary
for using the modem to make a connection.

Browse Site Database

Browsing a site database in the Site Book populates the site database
on the Workstation in the path specified.

Note:  Browsing is not permitted when M-Application clients are
connected to the OLE for Process Controls (OPC) server.

Browse Site Database defines the device names of the N30 controllers
on a site, and generates a database of communication information for
the devices and objects that reside on that site. This communication
information is loaded at the startup of the BACnet OPC server and
allows faster communication to an object. Use Browse Site Database
after downloading to an N30 so that the views displayed in all
M-Application (OPC) clients are updated.

Clicking the Browse Site Database button from the main Site Book
screen brings up the BACnet Object Finder screen. From this screen,
you can add a device or allow Site Book to automatically find all
devices on the LAN for the given port of the site. If the site uses a
DNS server, you can add and edit host names for devices from this
screen as well.
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A feature of Project Builder that allows you to test databases in a
virtual N30 prior to downloading them to actual N30s. To use the
simulator, set up a site as an Ethernet connection in Site Book with
Internal Routing enabled. Internal Routing is one of the Advanced
Parameters of the Ethernet connection in Site Book.

Site Book Database Files

The Site Book has two types of database files. The sites database file
and the site objects database files. The sites database (sites.mdb)
contains the names and communications parameters for the sites to
which an M-Series Workstation or PC with M-Tool can connect. The
site objects database file (“name of site”.mdb) contains data about the
BAChet objects on a particular site. There is a separate site objects
database file for each site. The sites database file is located in the
M-Data directory. The M-Data directory is shared by several
Johnson Controls M-Series products. The location of a site’s site
objects database file defaults to the M-Data directory but may be
changed by the Site Book user.

Note for Upgraders

The default location for Site Book database files for new installations
was changed from Release 1.x to Release 2.x. Note that upgrading an
M-Series Workstation or M-Tool from Release 1.x to Release 2.x does
not change the location of the existing M-Data directory. If M-Data
was located at C:\Program Files\Johnson Controls\M Data\, it remains
there after the upgrade. An upgrade preserves the locations of existing
program and data files. However, if you upgrade an M-Series
Workstation, you must rebrowse the devices. See Table 2 for a listing
of Site Book default database file locations.

Table 2: Database Locations

Installation File Release Location
Upgrade from  Sites.mdb 1.x C:\Program Files\Johnson Controls\M Data\
Release 1.x “name of site”.mdb  1.x C:\Program Files\Johnson Controls\M Data\
New Sites.mdb 2.x C:\Documents and Settings\All Users\Application
Data\Johnson Controls\M-Data\
“name of site”.mdb  2.x C:\Documents and Settings\All Users\Application

Data\Johnson Controls\M-Data\
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Site Book Basic Parameters

The basic parameters are available for editing by default when you add
or view a site in Site Book. See Figure 23 for an example. Table 3
contains a list of basic parameters and their definitions.

Table 3: Site Book Basic Parameters

Parameter Definition

Site Name An ASCII string with a maximum length of 32 characters. This string must be defined in
all Data Source Names (DSNs) passed from the OPC client to the OPC server. The
Site Name is the primary key into the site database. The information in the rest of this
table is required to describe the site. This field is required when adding a site.

System Defines the system type being accessed at the site. The system type is an enumeration
defined as BACnet.

Connection Identifies the type of connection used when communicating or connecting to a

particular site. This field is required when adding a site and can take on the values of
Ethernet, direct serial, or dial-up (modem).

Note:  Multiple connection types may be defined for a site. To switch between
connection types, double-click in the connection field to display a drop-down
list of connection options. An M-Series Workstation uses the last selected
connection type for a site whenever it connects.

Network Number

Identifies the network. This field is required when adding a site. The network number
can range from 1 through 65535 for Ethernet, direct serial, or dial-up (modem)
connections. The default value for Ethernet is 1001, and the default for direct serial or
dial-up (modem) is 100. The network number is used for message routing at the
network layer. The network number must be unique on the LAN.

DataBase Path

The location where the object database is saved. This path may be different for each
site and the user can configure the path.

Site Description

Describes the site. This field is limited to 125 characters. The default is blank.

Workstation Name

Lists the workstation name. This field is limited to 20 characters. The default is the
name of your machine. If the machine name is blank, the default is M-WS1. The
workstation name is used for reporting alarm events and must be unique for each
workstation on a site.

Workstation
Number

A unique number identifying the workstation. This must be a positive number limited
to 65000. The default is 1. The workstation number is used for reporting alarm events
and must be unique for each workstation on a site. Refer to the N30 Supervisory
Controller Networking Technical Bulletin (LIT-6891300) for details.

Connection
Control

Can be User or System. User connection requires an explicit connect/disconnect to the
site. The System connection specifies that the connection is made dynamically by the
system. The default for the first Ethernet connection defined is System connection.
The default for dial and direct is User connection.

Note:  Only Ethernet sites can be system connected, and only one site can be
system connected.
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Site Book Advanced Parameters

Table 4 describes the advanced parameters that apply to all Site Book
connections.

Table 4: Site Book Advanced Parameters (General)

Parameter Definition

Dormant Rate Time in seconds used to compute the dormant period for the OPC server to keep data
for an object updated after all M-Series Workstation clients no longer reference the
object. Dormant period is the dormant rate multiplied by the dormant cycle. The default

is 0 seconds.
Dormant Cycle Number of cycles used to compute the dormant period. The default is 0 cycles.
Segment Timer Timeout value used for segmented BACnet messages. The default is
Length 4000 milliseconds. The maximum value can be 60000 milliseconds.
Request Timer Timeout value used for BACnet messages. The default is 6000 milliseconds. The
Length maximum value is 60000 milliseconds.
Number of Retries Number of times a failed message is retrieved. The default is 4. The maximum value
is 100.

Table 5 describes the advanced parameters specific to Ethernet
connections.

Table 5: Site Book Advanced Parameters for Ethernet Connections

Parameter Definition

BACnet IP Port Required for Ethernet connection and must be unique within a site. When the
connection information is defined as Ethernet, the BACnet IP Port address must be
defined. The BACnet IP Port address is BACO (47808) by default.

Protocol Defines the data link software that runs on the Ethernet connection. The default
protocol is IP. If communicating with N30s, do not change this parameter.

802.3 Routing Allows routing between the IP and 802.3 router. This is used for diagnostic purposes.
The default is disabled. Do not change this parameter.

Internal Routing Allows routing between the IP and internal devices. This is used for diagnostic
purposes. The default is disabled. Internal routing must be enabled to use the Project
Builder’'s Simulator feature.

Table 6 describes the advanced parameters specific to direct connect
and dial-up (modem) connections.

Table 6: Site Book Advanced Parameters for Direct Connect and Dial-up
(Modem) Connections

Parameter Definition

Phonebook Entry  Ties a site name to a matching Microsoft dial-up networking configuration. This
phonebook entry contains information such as baud rate, phone number, and dialing
prefix.

Password Serial communication and PPP password for the N30. The default is 2468.

Login ID Serial communication and PPP login ID for the N30. The default is jci.
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Ethernet Setup Overview

The flowchart in Figure 1 provides a general overview of the steps
required to set up Ethernet communications to N30 sites.

Start

4

Install Ethernet card in accordance with
manufacturer's instructions.

A
Check the IP address.
See the appropriate procedure in this document:
* Checking the Ethernet Related Addresses of a PC Running Windows 98 Software
* Checking the Ethernet Related Addresses of a PC Running Windows NT Software
* Checking the Ethernet Related Addresses of a PC Running Windows 2000 Software

A
Change the IP address of the Ethernet card in your PC.
See the appropriate procedure in this document:
* Setting the Ethernet Related Addresses on a PC Running Windows 98 Software
* Setting the Ethernet Related Addresses on a PC Running Windows NT Software
* Setting the Ethernet Related Addresses on a PC Running Windows 2000 Software

Go to the Site Book and define the site.
See Adding an Ethernet LAN Site to Site Book in this document.

* To continue with generating databases for N30s, see the flowcharts in the
Database Generation section of the N30 Supervisory Controller Quick Start
Technical Bulletin (LIT-6891200).

* To continue with M3 Workstation installation and commissioning, see
Installation and Commissioning Overview in the M3 Workstation Overview and
Installation Technical Bulletin (LIT-1153100).

* To continue with M5 Workstation installation, see the Installing the M5
Workstation Technical Bulletin (LIT-1153300).

Note: If you have trouble uploading or downloading
N30s after these steps are completed, please see
the Networking Troubleshooting Guide section in
the N30 Supervisory Controller Networking
Technical Bulletin (LIT-6891300).

Comm setup ethernet.vsd

Figure 1: Ethernet Setup Overview
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The flowchart in Figure 2 provides a general overview of the steps
required to set up dial-up (modem) communications to N30 sites.

\
Windows 98 Software*

v

\
Windows NT Software**

v

Verify that Dial-up
Networking is installed. See
Installing Dial-up Networking .

Verify that Dial-up
Networking is installed. See
Installing Dial-up Networking .

A

4

\
Windows 2000 Software***

Verify that a modem is
installed. If it is not installed,
see Adding a Modem .

Verify that a modem is
installed. If it is not installed,
see Adding a Modem .

Verify that a modem is
installed. If it is not installed,
see Adding a Modem .

A

4

A

Go to Dial-up Networking
and add network connection
icons for the dial-up sites.
Each site with which you want
to establish a dial-up
connection must have its own
network connection icon. See
Creating a Network Connection
Icon .

Verify that Remote Access
Service (RAS) is installed
and add phonebook entries
for each site with which you
want to have dial-up
communications. See the
related procedures in the Direct
Connect and Dial-Up on
Windows NT Application Note
(LIT-6893400) .

Make a new dial-up
connection. See Making a
New Dial-up Connection .

A

Make a new dial-in
connection. See Making a
New Dial-in Connection .

Go to Site Book and define a site using the site's network connection icon
or phonebook entry. See Adding a Direct Serial or Dial-Up (Modem) Connection
Site in this document .

v

* To continue with generating databases for N30s, see the flowcharts in the
Database Generation section of the N30 Supervisory Controller Quick Start
Technical Bulletin (LIT-6891200) .

* To continue with M3 Workstation installation and commissioning, see
Installation and Commissioning Overview in the M3 Workstation Overview and
Installation Technical Bulletin (LIT-1153100) .

* To continue with M5 Workstation installation, see the Installing the
M5 Workstation Technical Bulletin (LIT-1153300) .

A 4

Done

The figure refers to Detailed Procedures in the following documents:
For Windows 98 references, see the Direct Connect and Dial-Up on Windows 98 Application Note (LIT-6893350) .
** For Windows NT references, see the Direct Connect and Dial-Up on Windows NT Application Note (LIT-6893400) .

*

*** For Windows 2000 references, see the Direct Connect and Dial-Up on Windows 2000 Application Note (LIT-6893450) .

Comm setup dial up.vsd

Figure 2: Dial-up (Modem) Setup Overview Diagram



18

Site Book User’s Guide

Direct Serial Connection Setup Overview

The flowchart in Figure 3 provides a general overview of the steps
required to set up direct serial communications to an N30 site.

\
Windows 98 Software*

v

\
Windows NT Software**

v

Verify that Dial Up
Networking is installed. See
Installing Dial-up Networking .

Verify that Dial Up Networking is
installed. See Installing Dial-up
Networking .

\
Windows 2000 Software***

Verify that Dial-up
Networking Serial Cable
Between 2 PCs is available
as a modem connection.
See Adding a Direct Serial
Connection Option under
Modems .

Verify that Dial-up Networking
Serial Cable Between 2 PCs is

available as a modem connection.

See Adding a Direct Serial
Connection Communications Port.

Verify that a null modem
serial cable is installed. If it
is not installed, see Adding a
Null Modem Serial Cable .

Go to Dial-up Networking
and add a network
connection icon for the
direct serial connection.
See Creating a Network
Connection Icon .

Verify that RAS is installed and
add phonebook entries for each
site with which you want to have
direct serial communications. See
the related procedures in the Direct
Connect and Dial-Up on

Windows NT Application Note
(LIT-6893400) .

Make a new direct serial
connection. See Making
a New Direct Serial
Connection .

4

Go to the Site Book and define a site using the direct serial connection's connection icon or
phonebook entry. See Adding a Direct Serial or Dial-Up (Modem) Connection Sitein this document.

(LIT-1153100) .

* To continue with generating databases for N30s, see the flowcharts in the Database Generation
section of the N30 Supervisory Controller Quick Start Technical Bulletin (LIT-6891200).

* To continue with M3 Workstation installation and commissioning see Installation and

Commissioning Overviewin the M3 Workstation Overview and Installation Technical Bulletin

* To continue with M5 Workstation installation, see the Installing the M5 Workstation Technical
Bulletin (LIT-1153300) .

A 4

Done

The figure refers to Detailed Procedures in the following documents:

For Windows 98 references, see the Direct Connect and Dial-up on Windows 98 Application Note (LIT-6893350).

** For Windows NT references, see the Direct Connect and Dial-up on Windows NT Application Note (LIT-6893400).
***For Windows 2000 references, see the Direct Connect and Dial-up on Windows 2000 Application Note (LIT-6893450).

Comm setup direct serial.vsd

Figure 3: Direct Serial Connection Setup Overview
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Procedure Overview

Table 7: Site Book Procedure Overview

To Do This

Follow These Steps:

Check the Ethernet Related
Addresses of a PC Running

1.

On the Windows Start menu, click Run.

2. In the Open field, type Winipcfg.
Windows 98 Software ) P ype Hiinipety
3. Click OK.
4. Click the Ethernet adapter on your PC on the drop-down list.
5. Note the addresses on the screen. The numbers on this screen must
be compatible with the N30s with which you want to communicate.
6. Click OK.
Check the Ethernet Related 1.  On the Windows Start menu, click Programs > Command Prompt.
Addresses of a PC Running 2. Type IPConfig.
Wind NT Softw
indows Software 3. Press the Enter key.
4. Note the addresses on the screen. The numbers on this screen must
be compatible with the N30s with which you want to communicate.
5. Click the Close button in the upper right corner of the screen to close
it.
Check the Ethernet Related 1.  On the Windows Start menu, click Programs > Accessories >
Addresses of a PC Running Command Prompt.
Windows 2000 Software 2. Type IPConfig.
3. Press the Enter key.
4. Note the addresses on the screen. The numbers on this screen must
be compatible with the N30s with which you want to communicate.
5. Click the Close button in the upper right corner of the screen to close
it.
Set the Ethernet Related IMPORTANT:  See the Notes and Caution in the Detailed Procedures
Addresses on a PC Running version of this process prior to performing these steps.
Windows 98 Software - - -
1. On the Windows Start menu, click Settings > Control Panel.
2. Double-click the Network icon.
3. Click the TCP/IP component of your Ethernet adapter in the list.
4. Click the Properties button.
5. If your network supports DHCP, click Obtain an IP address
automatically and go to Step 10. Otherwise, go to Step 6.
6. Click Specify an IP address.
7. Type in a valid IP address and subnet mask.
8. If you are not using a router, go to Step 10. If you are using a router,
click on the Gateway tab.
9. Type in a Gateway address to match the N30 router address.
10. Click the Add button.
11. Click OK to return to the Network Settings screen.
12. Click OK to close.
13. Restart your PC.

Continued on next page . . .
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To Do This (Cont.)

Follow These Steps:

Set the Ethernet Related
Addresses on a PC Running
Windows NT Software

IMPORTANT: See the Notes and Caution in the Detailed Procedures

version of this process prior to performing these steps.

ok 0N~

7.
8.

9.

10.
11.
12.

On the Windows Start menu, click Settings > Control Panel.
Double-click the Network icon.

Click the Protocols tab.

Click TCP/IP Protocol and click the Properties button.

Click your Ethernet adapter in the drop-down list.

If your network supports DHCP, click Obtain an IP address from a
DHCP server and go to Step 11. Otherwise, go to Step 7.

Click Specify an IP address.

Type in a valid IP address, subnet mask, and, if you are using a
router, a default Gateway address.

If you need to add more addresses, click the Advanced button.
Add, edit, or remove addresses as necessary and click OK.
Click OK to return to the Network Settings screen.

Click OK to close.

Set the Ethernet Related
Addresses on a PC Running
Windows 2000 Software

IMPORTANT: See the Notes and Caution in the Detailed Procedures

version of this process prior to performing these steps.

o

- O

On the Windows Start menu, click Settings > Network and Dial-up
Connections.

Right-click on the Local Area Connection and click Properties.
Click Internet Protocol (TCP/IP) and click the Properties button.

If your network supports DHCP, click Obtain an IP address
automatically and go to Step 9. Otherwise, go to Step 5.

Click Use the following IP address.

Type in a valid IP address, subnet mask, and, if you are using a
router, a default Gateway address.

If you need to add more addresses, click the Advanced button.
Add, edit, or remove addresses as necessary and click OK.

Click OK to return to the Local Area Connection Properties screen.
Click OK to return to the Network and Dial-up Connections screen.
Click the Close button to close the screen.

Add an Ethernet LAN Site to
Site Book

o w2220 2N

o

On the Main Site Book screen, press the Add button.
Click Ethernet LAN and click OK.

Fill in the fields according to Table 9 and click OK.
Edit the basic parameters.

If you need to edit the advanced parameters, click Advanced and edit
the fields as needed.

Click Close.

Add Device Addresses in
Segment Hop (SHOP)

—_

S

In the Advanced parameters screen of your Ethernet connection in
Site Book, click the SHOP button.

Click ADD IP Address.

Enter the IP address and click OK.
Click SAVE to save your changes.
Click Exit.

Continued on next page . . .
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To Do This (Cont.)

Follow These Steps:

Add Device Host Names in
SHOP

1. In the Advanced parameters screen of your Ethernet connection in
Site Book, click the SHOP button.

Click ADD Host Name.

Enter the host name and click OK.
Click SAVE to save your changes.
Click Exit.

Delete Device Addresses or
Host Names from SHOP

bl RS ol

In the Advanced parameters screen of your Ethernet connection in
Site Book, click the SHOP button.

Click on the device address or host name you want to delete.
Click DELETE Entry.

Click SAVE to save changes.

Click EXIT when finished.

Add a Direct Serial or Dial-up
(Modem) Connection Site

On the Main Site Book screen, press the Add button.
Click direct serial or dial-up (modem) and click OK.

Fill in the fields of the Serial Connection Information screen and
click OK.

Edit the basic parameters.

5. If you need to edit the Advanced parameters, click Advanced and edit
the fields as needed.

6. Click Close.

NN

&

Use Browse Site Database

1. Make sure that you are online with a device (physical or simulated).

2. Shut down any M-Applications (clients) that are running on your
machine.

3. On the main Site Book screen, with the desired site selected, click
the Browse Site DataBase button.

4. Click the Browse Devices button to browse all devices on the site, or
click the Select Devices button to choose specific devices to browse
from a list of currently added devices.

5. After the device objects are browsed, click Quit to return to the Site
Book.

Add a Device

1. In the BACnet Object Finder, click the Site to which you want to add
devices and click the Add Device button.

2. Enter the device name and host name (if DNS is used) and click OK.

Find Devices

In the BACnet Object Finder, on the left side of the screen, click the Site
for which you want to find devices and click the Find Devices button.

Edit a Device Host Name

1. In the BACnet Object Finder, click the device whose host name you
want to edit and click the Edit Host Name button.

Enter the new host name and click OK.

Delete a Site from Site Book

Click a Site in the list on the left side of the main Site Book screen.
Click the Delete button.
Click yes to confirm the deletion.

@ N =S

Continued on next page . . .
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To Do This (Cont.)

Follow These Steps:

Connect to an N30 Site from
Project Builder via a Direct
Serial Connection

1.

Connect a NULL modem cable from the N30 port to the PC COMM
port on the PC on which the Dial-up Networking Serial Cable modem
was defined.

2. Use Project Builder's Edit > Edit Sites dialog box to select the name
of the site that you want to connect.

3. Select the objects to upload or download.

4. On the Tools menu in Project Builder, select the Upload, Download,
or Advanced Download command as necessary.

Change the PPP Password 1. Close any open instances of Site Book.

2. In Project Builder, open the N30 device object by double-clicking the
correct row head.

3. Right-click on the M-View screen and click Snapshot Focus.

4. Scroll down to the Login ID and Password fields.

5. Edit as desired.

6. Click OK.

7. Save the database.

8. Download the N30 to which you are connected using the old PPP
Login ID and Password. (That is, with the PPP Login ID and
Password still at the old values in Site Book.)

9. On the Edit menu of Project Builder, click Edit Site.

10. Click the Directory button.

11. Click the Advanced button.

12. Edit the Login ID and Password to match the Login ID and Password
in your site database in Project Builder.

13. Click Close.

14. Click OK.

15. On the Project Builder File menu, click Save.

Change the BACnet IP Port 1. Close any open instances of Site Book.

2. In Project Builder, open the N30 device object by double-clicking the
correct row head.

3. Right-click on the M-View screen and click Snapshot Focus.

4. Scroll down to the BACnet IP Port field.

5. Edit as desired.

6. Click OK.

7. Save the database.

8. Download the N30 to which you are connected using the old BACnet
IP Port. (That is, with the BACnet IP Port still at the old values in Site
Book.)

9. On the Edit menu of Project Builder, click Edit Site.

10. Click the Directory button.

11. Click the Advanced button.

12. Edit the BACnet IP Port to match the BACnet IP Port in your site
database in Project Builder.

13. Click Close.

14. Click OK.

15. On the Project Builder File menu, click Save.
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Detailed Procedures

Note:  The instructions that pertain to Ethernet connections in this
document assume that your PC has a working Ethernet card
installed and configured properly.

Checking the Ethernet Related Addresses of a PC Running
Windows 98 Software

To check the Ethernet related addresses of a PC running Windows 98
software:

On the Windows Start menu, click Run. The Run dialog box appears
(Figure 4).

Run EE

Type the name of a program, folder, document, ar [nternet
rezource, and Windaows will oper it for pou.

-

Cancel Browse. . |

Figure 4: Run Dialog Box
In the Open field, type Winipcfg.

Note:  This utility is normally in the Windows directory. If you
cannot find it, select Files or Folders from the Find menu on
the Windows Start menu and search for winipcfg.exe.

Click OK. The IP Configuration screen appears (Figure 5).
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IP Configuration = =] |

—Ethernet Adapter Information

ACom EtherLink, PCI

Adapter Addrezs | 22-CB-01-T5-ED-LL
IP Address | 177.223.20.151
SubnetMask | 245.255.254.2
Default Gateway | 148.222.11.3

| ] I Releaze | Renew |

Releaze All | Rerew Al | More [nfo s |

Figure 5: Windows IP Configuration Screen
Click the Ethernet adapter on your PC in the drop-down list.

Note the addresses on the screen. See Table 8 for information on the
displayed addresses. The numbers on this screen must be
compatible with the N30s with which you want to communicate.

Click OK.

Table 8: Ethernet Adapter Information

Field Meaning

Adapter Address Media Access Control (MAC) Address of the Ethernet card in your PC. Each device on
an Ethernet network must have a unique MAC address.

IP Address IP address currently assigned to your PC
Subnet Mask Subnet mask currently assigned to your PC
Default Gateway Router address

Checking the Ethernet Related Addresses of a PC Running
Windows NT Software

To check the Ethernet related addresses of a PC running Windows NT
software:

1. On the Windows Start menu, click Programs > Command Prompt.
2. At the command prompt, type IPConfig.

3. Press the Enter key. The Windows NT IP Configuration
information screen appears (Figure 6).
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% Command Prompt
Ethernet adapter E178x1:

IPF Address. . . 148.222.11.3
Subnet Mask . . 255.255.254.2
Def ault Gateway 127.25.13.4

PPP adapter Hdislanb:

IP Address. . .
Subnet Mask . .
Default Gateway

PPP adapter Mdizlan?:
IP Address. . .
Subnet Mazk . .
Default Gateway

PPP adapter HdislWan4d:
IP Address. . .
Subnet Maszk . .
Default Gateway

C:sWINNT“Profiless~Administrator~Desktop>

Figure 6: Windows NT IP Configuration

25
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4. Note the addresses on the screen. See Table 8 for information on
the displayed addresses. The numbers on this screen must be
compatible with the N30s with which you want to communicate.

5. Click the Close button in the upper right corner of the screen to
close it.

Checking the Ethernet Related Addresses of a PC Running
Windows 2000 Software

To check the Ethernet related addresses of a PC running
Windows 2000 software:

I. On the Windows Start menu, click Programs > Accessories>
Command Prompt.

2. At the command prompt, type IPConfig.

Press the Enter key. The Windows 2000 IP Configuration
information screen appears (Figure 7).

[ Command Prompkt

Microsoft Windows 2888 [Uersion 5.80.21951
CC» Copyright 1985-28008 Microsoft Corp.

Czs>Ipoconfig

Windows 288@ IP Configuration

Ethernet adapter Local Area Connection:

Connection—=specific DNS Suffix
IP Addres=. . . . . .
Subnet Mask . . . . .
Default Gateway . . .

mke .cg.jci.com
159.222 _26.91
255.255.254_8
159 .222_26.2

Figure 7: Windows 2000 IP Configuration
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4. Note the addresses on the screen. See Table 8 for information on
the displayed addresses. The numbers on this screen must be
compatible with the N30s with which you want to communicate.

5. Click the Close button in the upper right corner of the screen to
close it.

Setting the Ethernet Related Addresses on a PC Running
Windows 98 Software

IMPORTANT: For a PC running an M-Series Workstation or M-Tool
to communicate with N30s on an Ethernet network,
the IP addresses should be within certain parameters.
These instructions assume you are setting up a
dedicated Ethernet network for your
N30/M-Series Workstation system. If you are
connecting to a shared Ethernet network and your
network does not support DHCP, you must obtain
your IP addresses and Gateway addresses from your
Network Administrator.

Note:  Your screens may differ from the screen captures in the
following instructions, depending on other software you may
have installed on your machine.

To set the Ethernet related addresses on a PC running Windows 98
software:

1. On the Windows Start menu, click Settings > Control Panel.

2. Double-click the Network icon. The Network screen appears with
the Configuration tab selected (Figure 8).
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Hetwork E |

Configuration I |dentification |

The following petwork, components are inztalled:

i IP/SP-compatible Protocal - Dial-Up Adapter #2 NPN:_I
W MDISWAM -» Microsoft Virtual Private Networking &dapte

YT TCRAP > 3Com EtherLink (11 154 [3CBO3B-TPO] in PP

& TCPAP - DialUp Adapter

& TCPAP > DialUp Adapter #2 [WPN Suppart) -
“ | | 3

Bemowve | Properties I

Frimary Metwork Logon:
Movel Metisfare Clent _:I

File and Frint Sharing... |

— Dezcription

TCRAP ig the protocol pou use to connect to the Internet and
wide-area networks.

k. Cancel

Figure 8: Network Screen with Configuration Tab Selected
3. Click the TCP/IP component of your Ethernet adapter in the list.
4. Click the Properties button. The TCP/IP Properties screen appears

(Figure 9).
Note:  The addresses shown in these procedures are examples. Use
approved addresses from your System or Network
Administrator.

5. If your network supports DHCP, click Obtain an IP address
automatically and go to Step 11. Otherwise, go to Step 6 to
manually set your addresses.

Note:  Contact your Network Administrator to see if your network
supports DHCP.
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6. Click Specify an IP address (Figure 9).

A CAUTION: If you are connected to an Ethernet network that is
not dedicated to your N30/M-Series Workstation
system, do not change IP addresses without using
an approved address from your System
Administrator or IT Department.

TCP/IP Properties = |

Bindngs | Advanced | MetBlOS |
DMS Configuration I 3 ateway i WwiNS Configuration 1P Address

& IP addresz can be automatically azsigned to this computer.
If your network, does not autornatically azsign IP addresses, ask
your netwark. administrator for an addrezs, and then bupe it in
the zpace below.

¢ Dbtain an IP address automatically

(% Specify an P address: :

IP Address: [ 172. 16 . 11 .148 |

Subnet Mask:  |255.255.255. 0 |

Cancel |

Figure 9: TCP/IP Properties Screen - IP Address Tab
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7. Type in a valid IP address and subnet mask.

Notes:  Match the IP address to the first three octets of the N30.
Make the last octet within a few numbers of the N30. Keep
the subnet mask the same as the N30.

In the example in Figure 9, the N30 IP address is
172.16.11.145 and the subnet mask is 255.255.255.0.
Therefore, the IP address for the PC is set to match the first
three octets of the N30 (172.16.11) and the last octet is
within a few numbers (148 vs. 145) of the last octet of the
N30. The subnet mask is set the same as the subnet mask of
the N30.

8. If you are not using a router, go to Step 10. If you are using a
router, click on the Gateway tab. The TCP/IP Properties Gateway
screen appears (Figure 10).

TCP/IP Properties K E I

Bindngs | Advanced | Me®IDS |
DMS Configuration  Gateway i W IMS Configuration I IP Addresz

The firgt gateway in the Installed Gateway lizk will be the default.
The addresz order in the list will be the order in which these
machines are uzed.

Hew gateway:

.................................

172.16 . 8 . 2 i Add

= nztalled gateways:

1721682 Hemaye

K. Cancel

Figure 10: TCP/IP Properties Screen - Gateway Tab

9. Type in the Gateway address provided by your Network
Administrator. This address is for the router on the local subnet.

10. Click the Add button.
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11. Click OK to return to the Network Settings screen.
12. Click OK to close.
13. Restart your PC.

Setting the Ethernet Related Addresses on a PC Running
Windows NT Software

IMPORTANT: For a PC running an M-Series Workstation or M-Tool
to communicate with N30s on an Ethernet network,
the IP addresses should be within certain parameters.
These instructions assume you are setting up a
dedicated Ethernet network for your
N30/M-Series Workstation system. If you are
connecting to a shared Ethernet network and your
network does not support DHCP, you must obtain
your IP addresses and Gateway addresses from your
Network Administrator.

Note:  Your screens may differ from the screen captures in the
following instructions, depending on other software you may
have installed on your machine.

To set the Ethernet related addresses on a PC running Windows NT
software:

1. On the Windows Start menu, click Settings > Control Panel.

2. Double-click the Network icon. The Network screen appears with
the Identification tab selected (Figure 11).
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Figure 11: Network Screen with Identification Tab Selected
3. Click the Protocols tab (Figure 12).
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Metwork E |

|dentification | Services Protocols |.-’-'-.dapters| Bindings |

Hebwark, Protocals:

™ NwiLink, IP3/SF Compatible Transport
T MwLink NetBIOS
i3 TCF /P Protocal

Add... Remove | Ernperties...l | pdate

Drescription:

Tranzsport Control Pratocoldintermet Pratocol. The default wide
area network, protocal that provides communication across
diverze interconnected networks.

k. Cancel

Figure 12: Network Screen with Protocols Tab Selected

4. Click TCP/IP Protocol and click the Properties button. The
Microsoft TCP/IP Properties screen appears (Figure 13). If it is
not already on the IP Address tab, click the IP Address tab.

Note:  The addresses shown in these procedures are examples. Use
approved addresses from your System Administrator or
IT Department.
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Microzoft TCPAP Properhes |

IP Address | DNS | WINS Address | Routing |

An P addresz can be automatically aszigned to this network: card
by a DHCF zerver. |f your netwark. does nat have a DHCP zerver,
azk your netwark, administrator for an addreszs, and then tppe it in
the zpace below.

Adapter:

1

ACarn EtherLink 10100 PCI MIC [3C3058-Tx)

% Obtain an IP address fram a DHCP server

— ' Specify an IP address

|BFiddiess: |

Eritareh i asl |

[N erault [Fatet !

Advanced... l
] 4 I Cancel | e ] |

Figure 13: Microsoft TCP/IP Properties Screen -
IP Address Tab

Click your Ethernet adapter in the drop-down list.

6. If your network supports DHCP, click Obtain an IP address from
a DHCP server and go to Step 11. Otherwise, go to Step 7 to
manually set your addresses.

Note:  Contact your Network Administrator to see if your network
supports DHCP.

7. Click Specify an IP address (see Figure 14).

A CAUTION: Possible network problems. If you are connected
to an Ethernet network that is not dedicated to
your N30/M-Series Workstation system, do not
change IP addresses without using an approved
address from your System Administrator or
IT Department.
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Microzoft TCPAP Properhes I

IP Address | DNS | WINS Address | Routing |

An P addresz can be automatically aszigned to this network: card
by a DHCF zerver. |f your netwark. does nat have a DHCP zerver,
azk your netwark, administrator for an addreszs, and then tppe it in
the zpace below.

Adapter:
I[1] 3Cam EtherLink 10100 PCI NIC [3C9058-T) LI

€ Obtain an IP address fram a DHCP server

— (% Specify an IP address

|P Address: | 172 16 . 11 . 148

Subnet b azk; | AR 2R 28R 0

Defaultﬁatewa}l:l 172,16 . 8 . 2

] 4 Cancel Apply

Figure 14: Microsoft TCP/IP Properties Screen - IP Address
Tab with Specific IP Address

8. Type in a valid IP address, subnet mask, and, if you are using a
router, a default Gateway address.

Notes:  Match the IP address to the first three octets of the N30.
Make the last octet within a few numbers of the N30. Keep
the subnet mask the same as the N30.

In the example in Figure 14, the N30 IP address is
172.16.11.145 and the Subnet Mask is 255.255.255.0.
Therefore, the IP address for the PC is set to match the first
three octets of the N30 (172.16.11) and the last octet is
within a few numbers (148 vs. 145) of the last octet of the
N30. The subnet mask is set the same as the subnet mask of
the N30. The Gateway address is provided by your Network
Administrator. The Gateway address is for the router on the
local subnet.

9. [If you need to add more addresses, click the Advanced button.
The Advanced IP Addressing screen appears (Figure 15).
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Advanced IP Addressing E |

FEVa=Tal U £ | 30 om EtherLink, 10100 PCI MIC [3C9058-T )
—IF Addreszes
IP Address | Subnet Mask ]
1721611148 280 250 255.0
Add... Edi.. Remoyve |
— Qateways
i, |
[N |
Add.. Edit... Remove |
[ Enable PFTP Filtering
Enable SEcunt_l,l
[ERriae:.. |
] I Cancel

Figure 15: Advanced IP Addressing Screen

10. Add, edit, or remove addresses as necessary and click OK to
return to the Microsoft TCP/IP Addressing screen.

11. Click OK to return to the Network Settings screen.
12. Click OK to close.

Setting the Ethernet Related Addresses on a PC Running
Windows 2000 Software

IMPORTANT: For a PC running an M-Series Workstation or M-Tool
to communicate with N30s on an Ethernet network,
the IP addresses should be within certain parameters.
These instructions assume you are setting up a
dedicated Ethernet network for your
N30/M-Series Workstation system. If you are
connecting to a shared Ethernet network and your
network does not support DHCP, you must obtain
your [P addresses and Gateway addresses from your
Network Administrator.
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Note:  Your screens may differ from the screen captures in the
following instructions, depending on other software you may
have installed on your machine.

To set the Ethernet related addresses on a PC running Windows 2000
software:

1.  On the Windows Start menu, click Settings > Network and
Dial-up Connections. The Network and Dial-up Connections
screen appears (Figure 16).

Efl Network and Dial-up Connections =101 x|
J File Edit View Favorites Tools Adwvanced Help ﬁ
J 4= Back - =) - | @Search L, Folders @Histury | E" qs’ ] | EH~

J Address I Mebwork and Dial-up Connections j G0

-1 MNarme # | Twpe | Skatus | Device Marne
= L | rake Mew Connection
i =-Local Area Conneckion LAM Enabled 3Com 3C918 Integrated

Netwﬁrk and Dial-up
Connections

This Folder contains network,
conneckions For this computer, and a
wizard to help vou create a new
conneckion,

To create a new conneckion, click
Make Mew Connection,

To open a connection, click its icon.
To access sektings and components of
a conneckion, right-click its icon and

then click Properties.

To identify vour computer on the
nebwork, click Metwork Identification,

To add additional networking
components, click Add Mebwork,

Components.,

Select an item ko view its description,

1 |

| A

|2 objeck{s)

Figure 16: Network and Dial-up Connections Screen

2. Right-click on the connection to be used to access the N30
network and click Properties. The Properties screen for the
selected connection appears (Figure 17).
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Note:  The sample connection shown in Figure 16 is named Local
Area Connection. However, connection names vary
according to individual connection configurations. In Step 2,
select whichever connection the PC will use to communicate
with the N30s on the network.

Local Area Connection Properties 7| x|

General |

Connect using:

I ACom 3C913 Integrated Fazt Ethernet Caontraller [3C3058 -

Componentz checked are uzed by thiz connection:

W] % NwLink MetBIOS -
T WwLink IP/SPRMetBI0S Compatible Transport Proto

1| | v

Irstall... | Uninztall | Froperties |

— Descriptian

Tranzmizzion Contral Pratocaldnternet Pratocal. The default
wide area nebwork, protocal that provides commurnication
across diverze interconnected netwarks.

¥ Show icon in tazkbar when connected

k. | Cancel |

Figure 17: Properties Screen for Selected Connection

3. Inthe list of components, click Internet Protocol (TCP/IP) and
click the Properties button. The Internet Protocol (TCP/IP)
Properties screen appears (Figure 18).

Note:  The addresses shown in these procedures are examples. Use

approved addresses from your System Administrator or
IT Department.
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Internet Protocol {TCP/IP) Properties i |

General

Y'ou can get IP settings azsigned automatically if wour network, supparts
thiz capability. Othensize, vou need ta ask paur nebwork, adminiztratar for
the appropriate [P zettingz.

" Obtain an IP address automaticzally

—i¥ ilze the following |P address:

IF address: I 172 . 16 . 11 148
Subnet mazk: I 2Ph 28R 28R 0
Default gateway: I 1W2. 16, 8. 2

£ Dhtain DM S server address automatizally

—{* Use the following DN5 server addresses:

Frefered DMS zerver: I 199 222 0 4 . 94

Alternate DMS zerver: I 199 222 0 16 . 53

Advanced... |
k. I Caricel |

Figure 18: Internet Protocol (TCP/IP) Properties Screen

4. If your network supports DHCP, click Obtain an IP address
automatically and go to Step 9. Otherwise, go to Step 5 to
manually set your addresses.

Note:  Contact your Network Administrator to see if your network
supports DHCP.

5. Click Use the following IP address (see Figure 18).

A CAUTION: Possible network problems. If you are connected
to an Ethernet network that is not dedicated to
your N30/M-Series Workstation system, do not
change IP addresses without using an approved
address from your System Administrator or
IT Department.

6. Type in a valid IP address, subnet mask, and, if you are using a
router, a default Gateway address.
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Notes:

Match the IP address to the first three octets of the N30.
Make the last octet within a few numbers of the N30. Keep
the subnet mask the same as the N30.

In the example in Figure 18, the N30 IP address is
172.16.11.145 and the subnet mask is 255.255.255.0.
Therefore, the IP address for the PC is set to match the first
three octets of the N30 (172.16.11) and the last octet is
within a few numbers (148 vs. 145) of the last octet of the
N30. The subnet mask is set the same as the subnet mask of
the N30. The Gateway address is provided by your Network
Administrator. The Gateway address is for the router on the
local subnet.

7.

If you need to add more addresses, click the Advanced button.
The Advanced TCP/IP Settings screen appears (Figure 19).

Advanced TCP/IP Settings 2]

IP Settings | NS | WiINS | Options |

— P addieszes
IF addresz | Subnet magk
1721611148 280.285.255.0

agd.. | Edt. Remoye |
— Default gatewans:
[3 ateway | b etric: |
17216.8.2 1
agd.. | Ed. Remove

Interface metric: |1

Ok I Cancel

Figure 19: Advanced TCPI/IP Settings Screen

8. Add, edit, or remove addresses as necessary and click OK to
return to the Internet Protocol (TCP/IP) Properties screen.
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Click OK to return to the Properties screen for the selected
connection.

Click OK to return to the Network and Dial-up Connections
screen.

Click the Close button on the upper right corner of the screen to
close the Network and Dial-up Connections screen.

Adding an Ethernet LAN Site to Site Book

Note: We recommend that the maximum number of sites defined in

#' Site Book

the Site Book is 50.

To add an Ethernet LAN site to Site Book:

1.

On the Windows Start menu, click either Programs >

Johnson Controls > BACnet OPC > Site Book or Programs >
Johnson Controls > M-Tool > System Tools > Site Book. The Site
Book’s main screen appears (Figure 20). If this is the first time
you are running Site Book, all fields are blank.

& A

Add

Delete | Advanced |

Attribute | Walue | Help |

2.

Figure 20: Site Book - Blank Main Screen

Click the Add button. The Choose a Connection Type screen
appears (Figure 21).
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Choose a Connection Type |

— Connection Type

% Ethemet LAN Cancel |

' Direct Seial
" Modem [Dial-Up]

Figure 21: Choose a Connection Type Screen

3. Click Ethernet LAN and click OK. The Ethernet Connection
Information screen appears (Figure 22).

Ethernet Connection Information |

Site Mame I

M ebwork: Murmber I'I 0m
B&Chet IP Part 47308

M aote: Metwark. Mumber and BACHet [P Port
izt be configured to be the same as the
device

] I Cancel

Figure 22: Ethernet Connection Information Screen

4. Fill in the fields on the Ethernet Connection Information screen
according to Table 9 and click OK. The Site Book Basic
Configuration screen for Ethernet connections appears (Figure 23).

Table 9: Ethernet Connection Information Screen Fields

Field Default Notes

Site Name Blank The Site Name can be from 1 to 32 characters. It must be
unique and must be defined for each site.

Network Number 1001 The range is 1 to 65535. It must be defined for each site and

must match the network number defined in the N30 device
objects for this site.

BACnet IP Port 47808 (BACO in The range is 0 to 65000. It must be unique within a site. The
Hexadecimal) BACnet IP Port must match the one defined in the N30
Device objects for this site.”

* The BACnet IP Port cannot be changed using the Facilitator M-Tool.
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& A |

MIG300 DL
N30 with LO'T

niversal

bdd |

Azpen Elementar

Sauth Building

Delete | Browse Site DataB ase...

Attribute | W alue | Help |
System BACHet

Connection Ethernet

M etwark, Mumber 1001

D ataBaze Path C:ADocuments and Settiingsh...

Site Description | nternal

Whorkztation Mame arava2e3l

“Wworkztation Mumber 1
Connechion Cantral

System

bAdvanced

Cloze

Figure 23: Ethernet Connection - Basic Parameters

Edit the fields of the Basic Parameters screen as required
according to Table 10.

Table 10: Ethernet Connection - Basic Parameters Fields

Field Default Notes

System BACnet Defines system type. Currently limited to BACnet systems
and cannot be changed.

Connection Ethernet Set when adding a new site, but may be changed by
double-clicking. The choices are Ethernet, Direct Serial, or
Modem (Dial-up).

Network Number 1001 1001 is the default for Ethernet connections. The default for

Dial and Serial connections is 100.

DataBase Path

C:\Documents and
Settings\All Users\
Application Data\
Johnson Controls\
M-Data

Path may be different for each site. Clicking on the DataBase
Path field brings up the Browse Path button. The default path
at Release 1.x was:

C:\Program Files\Johnson Controls\M-Data\.

Site Description

Blank

Optional description of from 1 to 125 characters

Workstation Name

Your computer’s
name

Must be a unique workstation name up to 20 characters of
text.

Workstation Number

1

Must be a unique workstation number. The range is 1-65000.

Connection Control

System

System is the default for the first Ethernet site. For direct
serial and dial-up (modem) connections, the connection
control is User.

Note:

For a more detailed explanation of each field, refer to Table 3.
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6. If you need to edit the advanced parameters, click the Advanced
button. The Site Book Advanced Configuration screen for
Ethernet connections appears (Figure 24).

# Site Book =10 |
|:‘-‘~SEEH Elementari Attribute | e - Help |
MIG200 DL Syztem _ BAChet
. Connechion Ethernet

N30 with LOT

S outh Building M etwork, Humber 1001

Uriversal D.ataBase .F'Ellth C:hDocuments and Settingsh..
Site Deszcription Internal
Whiork station Marme a37a7e2e33
Whorkztation Mumber 1
Connection Contral Sypzhem
Dormant Rate 1]
Ciormant Cycle 1]
Segment Timer Lenath [meec] 4000
R equest Timer Length [mzec) G000
Murmber Of Retries 4 —
BACHet IP Part 47811
Protocal IP -
dne — I _>I_I

Add Delete | Browsze Site DataBase. . Cloze

Figure 24: Ethernet Connection - Advanced Parameters
7. Edit the additional fields as required according to Table 11.

Table 11: Ethernet Connection - Advanced Parameters Fields

Field Default Notes

Dormant Rate 0 Cannot exceed 65,000.

Dormant Cycle 0 Cannot exceed 65,000.

Segment Timer 4000 Cannot exceed 60,000 milliseconds.

Length (msec)

Request Timer Length 6000 Cannot exceed 60,000 milliseconds.

(msec)

Number Of Retries 4 Maximum of 100

BACnet IP Port 47808 (BACO) Cannot be changed from 47808 in N31s or Facilitator M-Tool.

Protocol IP Cannot be changed in Site Book.

802.3 Routing Disabled Cannot be changed in Site Book.

Internal Routing Disabled Leave disabled unless you are using the simulator feature of
Project Builder. Internal Routing must be enabled to use the
simulator.

Note:  For a more detailed explanation of each field, please refer to Table 4 and Table 5.

8. Click Close to save changes and exit Site Book.
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Adding Device Addresses in Segment Hop (SHOP)
Note:  This only applies to Ethernet connected sites.
To add device addresses in Segment Hop (SHOP):

1. Inthe advanced parameters screen of your Ethernet connection in
Site Book (Figure 24), click on the SHOP button. The Segment
Hop Devices screen appears (Figure 25).

Segment Hop Devices |

A0D Host Mame |

DELETE Entry |

¥ Broadcast

SAVE EXIT

Figure 25: Segment Hop Devices Screen

2. To add an IP address for the device on the target network segment
that contains the Broadcast Management object, click the ADD
IP Address button. The Device Address dialog box appears
(Figure 26).

Device Address |

Enter IP Address: I

ok CaMCEL |

Figure 26: Device Address Dialog Box
3. Enter the IP address and click OK.
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Note:  The following IP addresses are invalid:
- 0.0.0.0
- 255.255.255.255
- 127.0.0.1
4. Click ADD IP Address to add additional device addresses.

5. If you have an M-Series Workstation on an Ethernet segment that
contains N30s and their IP addresses are not listed in the Segment
Hop Devices screen, then check the Broadcast box.

Note:  Broadcast is not required if you are setting up a SHOP
address list for an M-Series Workstation on an Ethernet
segment that does not contain any N30 controllers. Broadcast
also is not required if the IP addresses of all the N30s are in
the SHOP list.

6. Click SAVE to save your changes.
7. Click EXIT when finished.

Adding Device Host Names in SHOP

Note:  This only applies to Ethernet connected sites.

To add device host names in SHOP:

1. Inthe advanced parameters screen of your Ethernet connection in
Site Book (Figure 24), click on the SHOP button. The Segment
Hop Devices screen appears (Figure 25).

2. To add a host name for the device on the target network segment
that contains the Broadcast Management object, click the ADD
Host Name button. The Host Name dialog box appears
(Figure 27).

Hoszt Hame Dialog

Mew Host Marne: I

] I Cancel |

Figure 27: Host Name Dialog Box
3. Enter the host name and click OK.

Note:  If Site Book cannot verify the host name you enter, it does
not add the host name to the list.

4. Click ADD Host Name to add additional host names.

If you have an M-Series Workstation on an Ethernet segment that
contains N30s, and their IP addresses or host names are not listed
in the Segment Hop Devices screen, then check the Broadcast
box.
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Note:  Broadcast is not required if you are setting up a SHOP

6.
7.

address list for an M-Series Workstation on an Ethernet
segment that does not contain any N30 controllers. Broadcast
also is not required if the IP addresses or host names of all
the N30s are listed.

Click SAVE to save your changes.
Click EXIT when finished.

Deleting Device Addresses or Host Names from SHOP

To delete device addresses or host names from SHOP:

1.

6.
7.

In the advanced parameters screen of your Ethernet connection in
Site Book (Figure 24), click on the SHOP button. The Segment
Hop Devices screen appears (Figure 25).

Click on the device address or host name that you want to delete.
Click DELETE Entry. The entry is removed.

To save your changes, click SAVE. Clicking EXIT without saving
allows you to exit Segment Hop without the devices being
deleted.

Delete additional device addresses or host names as necessary.
Click SAVE to save your changes.
Click EXIT when finished.

Adding a Direct Serial or Dial-up (Modem) Connection Site

Before adding a direct serial or dial-up connection to the Site Book,
Microsoft Dial-up Networking must be installed and configured. See
the Direct Connect and Dial-Up on Windows 98 Application Note
(LIT-6893350), the Direct Connect and Dial-Up on Windows NT
Application Note (LIT-6893400), or the Direct Connect and Dial-Up
on Windows 2000 Application Note (LIT-6893450) before proceeding.

Note: ~ We recommend defining a maximum number of 50 sites in

Site Book.
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To add a direct serial or dial-up (modem) connection site:

1. On the Windows Start menu, click either Programs >
Johnson Controls > M-Tool > System Tools > Site Book or
Programs > Johnson Controls > BACnet OPC > Site Book. The
Site Book’s main screen appears (Figure 20). If this is the first
time you are running Site Book, all fields are blank.

2. Click the Add button. The Choose a Connection Type screen
appears (Figure 21).

3. Click Direct Serial or dial-up (modem) and click OK. The Serial
Connection Information screen appears (Figure 28).

Serial Connection Information |
Site Mame ISDuth Building
Wwindows PhoneB ook Entry ISuuth Building j

Mew Windows Phonebook. E nkry |

Delete \Windows Phoneboak, E ntry |

Urnique Metwaork Murmber |1 0o

HOTE: The netwark, number must not be
duplicated on the zame LAMN.

Lagin ID Ici

Passwaord Ixm
o |

Figure 28: Serial Connection Information Screen

4. Fill in the fields on the Serial Connection Information screen
according to Table 12 and click OK. The Site Book Direct Serial
Basic Configuration screen appears (Figure 29).
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Table 12: Serial Connection Information Screen Fields

Field Default Notes
Site Name Blank The Site Name can be from 1 to 32 characters. It must be
unique and must be defined for each site.
Windows Phonebook First phonebook Selects the appropriate Dial-up Networking entry in the
Entry entry in list Windows phonebook that corresponds to this site.
New Windows N/A In Windows NT software, this button allows you to access the
Phonebook Entry Windows NT Dial-up Networking definition screens to add a
new Windows phonebook entry.
Note: In Windows 98 software, add a new phonebook
entry through Dial-up Networking.
Delete Windows N/A In Windows NT software, this button allows access to the
Phonebook Entry Windows NT Dial-up Networking screens to delete entries.
Note: In Windows 98 software, delete a new phonebook
entry through Dial-up Networking.
Unique Network 100 This number must be unique on the network. It must not
Number match the network number in N30 devices. The range
is 1-65535.
Login ID Blank Must match the PPP login ID in the N30.*
Password Blank Must match the PPP password in the N30.*

* The default login ID and password in N30s are jci and 2468.

# Site Book
Aspen Elementary Attribute | value | Help |
E*ITL“:EEND%EDLL Syztem BAChet
. Connechion Direct Senal
W30 with LOT
S outh Building Mebwark, Murmber 100 _
Universal D.ataBase .F'Ellth C:hDocuments and Settings. ..
Site Deszcription
Whiork station Marme a37a7e2e33
Whork gtation Murmber 1
Connection Contral Izer

Add Delete Browse Site DataBase... Advanced

Figure 29: Site Book Direct Serial Basic Configuration Screen

5. Ifnecessary, edit the fields of the Basic Parameters screen as
required according to Table 13.
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Table 13: Direct Serial Configuration Screen Basic Parameters

Field Default Notes

System BACnet Defines system type. Currently limited to BACnet systems.

Connection Direct Serial Set when adding a new site but may be changed by
double-clicking. The choices are Ethernet, Direct Serial, or
Modem (Dial-up).

Network Number 100 This number must be unique on the network. It must not

match the network number in N30 devices.

DataBase Path

C:\Documents and
Settings\All Users\
Application Data\
Johnson Controls\
M-Data

Path may be different for each site. Clicking on the DataBase
Path field brings up the Browse Path button. The default path
at Release 1.x was:

C:\Program Files\Johnson Controls\M-Data\.

This is the path created on installation.

Site Description

Blank

An optional site description of up to 125 characters can be
entered here.

Workstation Name

Your computer’s
name

Up to 20 characters of text. It must be unique for alarm
notification.

Workstation Number

1

From 1-65000. It must be unique for alarm notification.

Connection Control

User

Requires explicit connect/disconnect command from user
when using an M-Series Workstation. For direct serial and
dial-up (modem) connections, the connection control is User.
System is the default for the first Ethernet site.

Note:

6.

For a more detailed explanation of each field, refer to Table 3.

If you need to edit the advanced parameters, click the Advanced

button and edit the additional fields as required according to

Table 14.

Table 14: Direct Serial Configuration - Advanced Parameters Fields

Field Default Notes

Dormant Rate 0 Cannot exceed 65,000.

Dormant Cycle 0 Cannot exceed 65,000.

Segment Timer 4000 Cannot exceed 60,000 milliseconds.

Length (msec)

Request Timer Length 6000 Cannot exceed 60,000 milliseconds.

(msec)

Number Of Retries 4 Maximum of 100

Phonebook Entry N/A Windows Dial-up Networking entry defining serial
connections for this site

Password N/A PPP password for the N30

Login ID N/A PPP login ID for the N30

Note: For a more detailed explanation of each field, refer to Table 4 and Table 6.

7.

Click Close to save changes and exit Site Book.
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Using Browse Site Database

IMPORTANT: Trying to use older databases (Release 1.x) with new
software displays a warning message that allows you
to upgrade the database from the Release 1.x format to
the Release 2.x format. If you have upgraded an
M-Series Workstation, you need to rebrowse your
devices to update the site object database.

The Browse Site Database feature of Site Book is used to add devices
to site databases, to browse sites, and to rebrowse sites. To use browse
site database:

1. Make sure that you are online with a device (physical or
simulated).

2. Shut down any M-Applications (clients) running on your PC.

Note:  If an M-Application client is running, Browse displays an
error.

3. On the main Site Book screen (Figure 30), click the Browse Site
DataBase button. The BACnet Object Finder screen appears

(Figure 31).
% Site Book =107 |
|»‘-‘~SEEH Elementari Atribute | value | Help |

System BACHet

rI':IIHSIIEIIB»EiIt]hDLLDT Connection Ethernet

S auth Building M etwark, Mumber 1001

Universal D ataBaze Path C:ADocuments and Settiingsh...
Site Description | nternal
Whorkztation Mame arava2e3l
"work gtation Mumber 1
Connection Control System

Add Delete | Browse Site DataB ase... bAdvanced

Figure 30: Basic Ethernet Connection
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i " BACHet Dbject Finder
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Figure 31: BACnet Object Finder Screen

4. With the site you want to browse selected, click the Browse
Devices button to browse all devices on the site, or click the
Select Devices button to choose specific devices to browse from a
list of currently added devices.

5. See Adding a Device, Finding Devices, and Editing a Device Host
Name for other tasks that can be performed from this screen.
Otherwise, after the device objects are browsed, click Quit to
return to the Site Book.

Adding a Device

Note:  Use this procedure while in the Browse Site Database

feature. See the Using Browse Site Database procedure.
To add a device:

1. On the left side of the BACnet Object Finder screen (Figure 31),
click the Site to which you want to add devices and click the Add
Device button. The Device Entry Dialog dialog box for the
selected site appears (Figure 32).
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Device Entry Dialog - BREMGEL

Enter Mame: I 0k I

Erter Host Mame: I Cancel

Figure 32: Device Entry Dialog Dialog Box
2. Enter the name of a device in this site’s database.

3. Ifthe N30s in this site are configured to use a DNS server, enter
the host name of the device as well. If a DNS server is not used,
leave the Enter Host Name box blank.

Notes: The Enter Host Name box appears only if the site uses an
Ethernet connection.

The Host Name may be the Object Name (such as
Buildingl) or a fully qualified host name that includes the
Object Name and the domain name (such as
Buildingl.Medctr).

4. Click OK.
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Finding Devices

Note:  Use this procedure while in the Browse Site Database
feature. See the Using Browse Site Database procedure.

To find devices, click the Site for which you want to find devices (on
the left side of the BACnet Object Finder screen [Figure 31]) and click
the Find Devices button.

Site Book locates all devices on the LAN for the port of the selected
site and adds them automatically.

Editing a Device Host Name

If an N30 host name changes, use this procedure to manually change
the host name of the device in Site Book.

Notes:  Use this procedure while in the Browse Site Database
feature. See the Using Browse Site Database procedure.

The Edit Host Name feature is only available if the site uses
an Ethernet connection.

To edit a device host name:

1. On the left side of the BACnet Object Finder screen (Figure 31),
click the device whose host name you want to edit and click the
Edit Host Name button. The Host Name Dialog dialog box for the
selected device appears (Figure 33).

Host Mame Dialog

Mew Host Marme: I

k. I Cancel |

Figure 33: Host Name Dialog Dialog Box

2. Enter the new host name and click OK.
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Deleting a Site from Site Book
To delete a site from Site Book:

1. Open Site Book. The main Site Book screen appears (Figure 34).

# Site Book I 3
Aspen Elementary Atribute | value | Help |
BRENGEL System BACHet
MIG300 DL . . .

. Connection Direct Serial

M0 with LOT

itk B Ll M etwork, Humber 100

hiversal D_ataEase _F'e_:th C:ADocuments and Settiingsh...
Site Description
Whork ztation Mame a7ave2ha3
“Wworkztation Mumber 1
Connechion Cantral |zer

Add Delete | Browse Site DataB ase... bAdvanced

Figure 34: Site Book - Main Screen

2. Click the site you want to delete.

3. Click the delete button. Site Book prompts you to click Yes if you
are sure that you want to delete the site.
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Connecting to an N30 Site from Project Builder via a Direct Serial

Connection

If using Windows 98 software and you have not set up the network
connection icon for the site to which you want to connect, see the
Direct Connect and Dial-Up in Windows 98 Application Note
(LIT-6893350) in this manual before proceeding. If using

Windows NT or Windows 2000 software and you have not set up your
phonebook entry for the site to which you want to connect, see the
Direct Connect and Dial-Up on Windows NT Application Note
(LIT-6893400) or the Direct Connect and Dial-Up on Windows 2000
Application Note (LIT-6893450) before proceeding. See the Project
Builder User’s Guide for more information on using Project Builder.

To connect to an N30 Site from Project Builder via a direct serial
connection:

1. Connect a NULL modem cable from the N30 port to the PC
COMM port on the PC on which the Dial-up Networking Serial
Cable modem was defined.

Notes:  See the N30 Supervisory Controller Installation Technical
Bulletin (LIT-6891300) for information about NULL modem
cables that work with the N30.

Choose an N30 port whose baud rate matches the baud rate
defined for the site’s network connection icon. The M-Tool
communications component can talk to an N30 through any
port with a matching baud rate.

2. Use Project Builder’s Edit > Edit Sites dialog box to select the
name of the site to which you want to connect.

Select the device or objects to upload or download.

4. On the Tools menu in Project Builder, select the Upload,
Download, or Advanced Download command as necessary.

A connection is established automatically with the controller. When
the connection is successful, the standard Windows connect icon
appears in the system tray.

When the upload or download is complete, the communications
component prompts whether to close the connection. By selecting No,
the connection is kept open for additional uploads or downloads.

Changing the PPP Password

The PPP password in Site Book must match the PPP password in the
N30 device object for the site to which you want to connect. Changing
the PPP password requires changing it in both Project Builder and Site
Book. For further information on the use of Project Builder, see the
Project Builder User’s Guide.
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To change the PPP password:
1. Close any open instances of Site Book.

2. In Project Builder, open the N30 device object by double-clicking
the correct row head. The M-View screen appears (Figure 35).

Edit Attributes - South Building E2

Configuration -
—Ohject
Ohbject Mame ISDL,ﬂh Biilding
Cescription I
Ohject Type |N30
Ohject Categary IHVAC j
— State —Fart Setup
UTC Offzet 360 minutes: Port 1 Baud Rate Igsuu j
—Daylight Savings [P 2 (] el IQBDD j
DST Enabled |True j Port 3 Baud Rate |5-,rsgg j
DST Latest Begin |  Memary Sizing
DST Latest End | Acquired Pool Size |1suuuu
Standard Time Units |CST GOO Queue Size |E| ;I

Browszer... | QK I Cancel | el |

Figure 35: N30 Device Object M-View Configuration Screen in Project Builder

3. Right-click on the M-View screen and click Snapshot Focus. The
Snapshot Focus screen appears (Figure 36).



58 Site Book User’s Guide

Edit Attributes - South Building
Miiew |

Snapshot Focus ﬂ
Object Mame ISouth Building
Description I
Query String I
Status INormaI
Enabled ITrue j
Execution Priotity IN.:.rmal j
Ohject Category IHVAC j
Functional MName ISDL,ﬂh Biuilding
Full Refersnce ISouth Building
Alarm State INormaI
BACnet Object Type  |B&CDevice hd

Browser. .. | QK. I Cancel | Helq |

Figure 36: N30 Device Object M-View Snapshot Focus Screen in
Project Builder

4. Scroll down to the Login ID and Password fields.

5. Edit as desired.

6. Click OK.

7. Save your database by clicking Save on the File menu.

Note:  The changes are not properly registered to the Site Data
object until you download all devices on the site.

8. Download the N30 to which you are connected without changing
the old PPP Login ID and Password in Site Book.

IMPORTANT: After the N30 is downloaded and before any other PPP
communication connections are made, you must
perform Steps 9 through 15.

9. On the Edit menu of Project Builder, click Edit Site. The Edit Site
screen appears (Figure 37).
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Edit Site ]|

Site hame: ISDuth Building j Dhirechary |

Site Manager device: I e

[
[

Copy Holder device: I

kin paszword length: |1

Site Group object: I

Alarm Bouting Ophions

& Use Message Fouter to route alarms automatically.

' Use Notifization objects to route alarms.

[ Create Beport Server for WT100 alamms.

k. I Cancel

Figure 37: Edit Site Screen

10. Click the Directory button. Site Book opens to the basic
parameters screen for this site.

11. Click the Advanced button.

12. Edit the Login ID and Password to match the Login ID and
Password in your site database in Project Builder.

13. Click Close to close Site Book and return to the Edit Site screen.
14. Click OK. The changes are saved to your project database.
15. On the Project Builder File menu, click Save.

Changing the BACnet IP Port

The BACnet IP Port in Site Book must match the BACnet IP Port in
the N30 device object for the site to which you want to connect.
Changing the BACnet IP Port requires changing it in both Project
Builder and Site Book. For further information on the use of Project
Builder, see the Project Builder User’s Guide.

To change the BACnet IP Port:
1. Close any open instances of Site Book.

2. In Project Builder, open the N30 device object by double-clicking
the correct row head. The M-View screen appears (Figure 35).

3. Right-click on the M-View screen and click Snapshot Focus. The
Snapshot Focus screen appears (Figure 36).

4. Scroll down to the BACnet IP Port field.
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3.
6.
7.

Edit as desired.
Click OK.

Save your database by clicking Save on the File menu.

Note:  The changes are not properly registered to the Site Data

8.

object until you download all devices on the site.

Download the N30 to which you are connected without changing
the old BACnet IP Port in Site Book.

IMPORTANT: After the N30 is downloaded and before any other

Ethernet communication connections are made, you
must perform Steps 9 through 15.

10.

11.
12.

13.
14.
15.

On the Edit menu of Project Builder, click Edit Site. The Edit Site
screen appears (Figure 37).

Click the Directory button. Site Book opens to the basic
parameters screen for this site.

Click the Advanced button.

Double-click the BACnet IP Port value and edit it to match the
BAChnet IP Port in your site database in Project Builder.

Click Close to close Site Book and return to the Edit Site screen.
Click OK. The changes are saved to your project database.

On the Project Builder File menu, click Save.
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Table 15: Site Book Troubleshooting Guidelines

Error/Condition

Problem

Solution

Disconnected from site
<site name> due to
Remote Access Service
(RAS) Error Code 721:
Remote PPP peer is
not responding.

Invalid PPP login ID and/or
password

Verify that the PPP login ID and password in
Site Book match the login ID and password in
the N30 object.

Connection does not
occur as expected.

Wrong connection type

Double-click the connection field on the Site
Book and click the proper connection type in
the drop-down list.

With a dial-up or direct
serial connection, either
browsing device fails
because it cannot connect
to site, or Project Builder
download/upload fails with
Error Code 282.

Wrong network number

Make sure that the network number entered in
the Site Book for dial-up (modem) or direct
serial connections, does not match the
network number of the N30 site to which you
are trying to connect.

When browsing a site for
new objects, you receive
the following message:
Object database is old.
Select yes to convert to a
new database.

Attempting to use older
databases (Release 1.x)
with new software

If you have upgraded M-Tool or an M-Series
Workstation, rebrowse the device. The old Site
Book object database for each site is saved
with a .old extension.
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